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Welcome to This Guide

Welcome to the LoadRunner Enterprise Quick Start. LoadRunner Enterprise is Micro Focus's Web-
enabled global performance testing tool, designed to streamline the testing process and increase
the test efficiency for multiple concurrent performance tests across multiple geographic locations.

This Quick Start is a self-paced guide designed to lead you through the process of creating,
running, and analyzing a performance test, and to introduce you to the LoadRunner Enterprise
testing environment.

Note: This guide assumes that your LoadRunner Enterprise environment has been fully
installed and configured, and that a domain and project have been set up. For details,

contact your LoadRunner Enterprise administrator.

How This Guide is Organized

This guide contains the following lessons:

Lesson

"Introducing
LoadRunner
Enterprise" on page 6

"Creating Vuser
Scripts" on page 8

"Creating and
Designing
Performance Tests" on
page 13

"Running Performance
Tests" on page 19

"Post-Run Analysis
and Trending" on
page 24

LoadRunner Enterprise (2020-2020 SP1)

Description

Provides an overview of LoadRunner Enterprise and the
performance testing applications.

Describes the steps involved in recording Vuser scripts using Virtual
User Generator.

Describes the steps involved in creating and designing performance
tests.

Describes the steps that are necessary before running a performance
test, and how fo begin test execution.

Describes how to analyze test run data using LoadRunner Analysis,
and how to view performance improvements and regressions using
the Trend Reports feature.
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Chapter 1: Introducing LoadRunner
Enterprise

This lesson provides a brief overview of LoadRunner Enterprise, and of the applications that are
involved in the testing process.

Notes:

e The Quick Start describes how to run a performance test with a single host functioning as
both a Controller and a load generator (C+LG). However, due to possible heavy load on the
Controller and load generator hosts during a performance test, it is best practice to assign
these functions to separate host machines.

e Ensure that the latest standalone versions of Virtual User Generator (VuGen)
and LoadRunner Analysis are installed on your system.

o You can find additional help on developing a Vuser script in VuGen, with a step-by-step
example, in the LoadRunner Tutorial.

In this lesson you will learn about:

"LoadRunner Enterprise Testing Process" below

"Performance Testing Applications" on the next page

LoadRunner Enterprise Testing Process

Using LoadRunner Enterprise, you create performance tests in which you define the events that occur
during a testing session. During a fest, LoadRunner Enterprise replaces human users at physical
machines with virtual users, or Vusers. These Vusers create load on your system by emulating actions of
typical users in a repeatable and predictable manner.

What is the testing process?

The testing process consists of the following basic processes:

Creating the script. Capturing typical end-user business processes performed on your application.

Designing the performance test. Setting up the test environment by defining events that occur
during the testing session.

Preparing to run the performance test. Adding the performance test to a test set and reserving a
timeslot for the test.

Running the performance test. Driving, managing, and monitoring the test.

Analyzing the results and viewing performance trends. Analyzing the performance data generated
during the test run, and viewing trending information which identifies performance improvements
and regressions over fime.
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These processes are explained in more detail in the lessons that follow.

Performance Testing Applications

Each step in the testing process is carried out by one of the Micro Focus performance testing tool
components. The components are as follows:

Application Description

Virtual User = Creates the script and generates virtual users, or Vusers. VuGen does this by

Generator capturing actions that typical end-users would perform on your application, and then

(VuGen) records these actions into automated Vuser scripts. These Vuser scripts form the
foundation of a performance test.

LoadRunner = Provides the central console from which you build, manage, and monitor a test.
Enterprise

Analysis Analyzes the performance test and provides graphs and reports with in-depth
performance analysis information. Using these graphs and reports, you can pinpoint
and identify the bottlenecks in your application and determine what changes need to
be made to your system to improve its performance.
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Chapter 2: Creating Vuser Scripts

This lesson explains the steps involved in recording Vuser scripts using Virtual User Generator.
In this lesson you will learn about:

¢ "Recording Vuser Scripts" below

Recording Vuser Scripts

You record Vuser scripts using Virtual User Generator (VuGen). A Vuser script is a record of a typical
end-user business process. VuGen works on a record-and-playback principle. As you walk through a
business process on your application, VuGen records your actions into an automated script which later
forms the foundation of the performance test.

Tip: You can find additional help on developing a Vuser script in VuGen, with a step-by-step
example, in the LoadRunner Tutorial.
This section includes:

o "How do | start recording user activity?" below
e "How do | record a script?" on the next page
e "How do | view my script?" on page 10

o "How do | save the script?" on page 12

How do | start recording user activity?

You begin by opening Vugen and creating a blank script.

1. Start VuGen.

l"

N
Double-click the Virtual User Generator ‘<" shortcut icon on your desktop. The VuGen Start Page
opens.

2. Create a blank Web script.

a. Inthetoolbar above the VuGen Start Page, click the Add New Script button <l The Create a
New Script dialog box opens.
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Create a New Script

Category: Protocol: Filter: E o
VuGen i Oracle - 2 Tier s Siebel - Web & Web Services
i e f Oracle - Web [ SMP (SAP Mobile Platiorm) % Windows Sockets
Multiple Protocols
] ote Oracle NCA 3 SMTP (Simple Mail Protocol)
Mabile and loT
Popular g POP3 (Post Office Protocel) B Teradici PColP
pecenl .e) @ RDP (Remote Desktop Protocol) [ TruClient - Mobile Web

[@ RTE (Remote Terminal Emulator) [ TruClient - Native Mobile

0 SAP - Web Tt TruClient - Web

r SAP GUI @ Web - HTTP/HTML

A protocol is the language that your client uses to communicate with the back end of the system.

b. Make sure the Category type is Single Protocol. VuGen displays a list of the protocols that are

available for a single-protocol script.

¢. Fromthe list of available protocols, select a protocol (example: for a Web-based application,

select Web - HTTP/HTML) and click Create. VuGen creates a blank Vuser script and displays the

script in the VuGen Editor.

How do | record a script?

The next stage in creating user emulation is recording the events performed by a real user. In the
previous section, you created an empty script. In this section, you will record a script.

Note: The following exercise explains how to record a scripts for a Web-based application (Web -

HTTP/HTML).

1. Start recording.

T o

In the Record into action box, select Action.

In Record, select Web Browser.

In the URL address box, type the URL address on the Web application under test.
Keep all other default settings.

-~ O O n
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The floating Recording toolbar opens.

00:00:20 [ (A

Recording... (24)
- o (@ | B

@ Ul % | Acton

%

&
=

2. Record your script.
Navigate through your Web application.

3. Stop recording.
Click the Stop Recording = button on the floating toolbar to stop the recording process.

VuGen generates the required code and inserts the code into the Vuser script.

How do | view my script?

VuGen recorded your steps from the moment you clicked the Start Recording button to the moment
you clicked the Stop Recording button. You can now use VuGen to view the script.

1. Display the Solution Explorer tab.
On the left side pane, make sure the Solution Explorer tab is selected.

Solution Explarer 1

= 4 Solution Untitled
m Ef WebHttpHtmi1
E @5 Actions
& vuser_init
g Action
& vuser_end
= [§ EsdraFiles
[ olobals.h
Egl Runtime Settings
& Parameters
[3 Feplay Fun Results
[= Recording Report

':g'; Solution Explorer | # Step Mavigator

This tab provides you structured access to the various parts of a Vuser script, as well as to a number
of files that are associated with the Vuser script.

2. Display the Step Navigator tab.
Click the Step Navigator tab.
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Line
12
21
23
24
G
B3
il
99

101
103
105

Step MNavigator

MName

o wieb 1y
@ yweh add
o wieb 1y
@ yweh add
@ yweh add

@ yweh add

[+
o wieb 1y

@ yweh add
@ yweh add
@ yweh add

@ yweh add

13 steps displayed

5 J__I g
Step Script
LIrl: Home WUISE
Service Adr wuse
Ul index ht wuse
Service Adr wuse
Service Adr wuse
Service Adr wuse
Ul index ht wuse
Service Adr wuse
Service Adr wuse
Service Adr wuse
Service Adr wuse

? Solution Explorer | # Step Navigatar

The Step Navigator displays an icon-based view of the script that lists the actions of the Vuser as
steps. For each action you performed during recording, VuGen generated a corresponding step in
the Step Navigator.

The Step Navigator displays a snapshot icon to indicate that a specific step contains a snapshot.

3. View a step in the VuGen Editor.

Make sure Tools > Options > Editor> General > Show Class\Function Browser is selected in the

VuGen Editor.

LoadRunner Enterprise (2020-2020 SP1)
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Double-click any step in the Step Navigator to display the corresponding function in the VuGen
Editor. The Editor displays a text-based view of the script.

basic_..torial : Action.c

@ HPYUGenC. Global Action * & Actiond)
L1 FElAction()

2

3

4 web_url{"WebTours™,

1 “URL=http: /{ webtours.com”,

=} "Resource=a",

7 "RecContentType=text/html",

& "Referer=",

9 "Snapshot=t1.inf",

1a "Mode=HTNL",

11 LAST) ;

12

13 1r think time(24);

14

15 web_submit_form(“login.pl®,

15 "snapshot=t2.inf",

17 ITEMDATA,

1& "Name=username", "Walue=jojo", ENDITEM,

19 "Name=password"”, "walue=bean™, EWMDITEM,

In the Editor, the actions of the Vuser are listed as API functions. VuGen uses color-coding to show
the functions and their argument values in the script. You can type C or API functions, as well as
control flow statements, directly into the script.

How do | save the script?

Select File > Save Script As and save the script locally on your desktop. For example, type Scripts. The
scripft file should be zipped. After you have created your performance test, you will upload the script to
LoadRunner Enterprise.

LoadRunner Enterprise (2020-2020 SP1)
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Chapter 3: Creating and Designing
Performance Tests

This lesson explains how to manage test assets in LoadRunner Enterprise, and the steps involved in
creating and designing a performance test.

In this lesson you will learn about:

e "Loggingin to LoadRunner Enterprise" below

e "Adding Vuser Scripts to LoadRunner Enterprise" on the next page
¢ "Monitoring Performance Tests" on the next page

¢ "Creating Performance Tests" on page 15

« "Designing Performance Tests" on page 16

Logging in to LoadRunner Enterprise

You log info LoadRunner Enterprise as follows:

1. Open your web browser and type the LoadRunner Enterprise Server URL
http://<LoadRunner Enterprise server name>/loadtest.

Note: If more than one LoadRunner Enterprise server is installed in your system together
with a load balancer, you should access LoadRunner Enterprise by entering the load
balancer's URL. Alternatively, you can also enter the server's defined internal URL.

2. The LoadRunner Enterprise Login window opens.

If LoadRunner Enterprise was configured for external authentication (SSO), the Login and
Password fields do not appear in this window and you should be redirected to your identity
provider’s login screen.

3. Inthe Login box, type your user name.
4. In the Password box, type the password assigned to you by your site administrator.

5. Select the Automatically log in to my last domain and project on this machine check box if you
want LoadRunner Enterprise to automatically log in to the last project in which you were working.

6. Click the Authenticate button. LoadRunner Enterprise verifies your user name and password and
determines which domains and projects you can access. If you specified automatic login,
LoadRunner Enterprise opens.

7. In the Domain list, select a domain. By default, the last domain in which you were working is
displayed.

8. In the Project list, select a project. By default, the last project in which you were working is
displayed.

9. Click Login. LoadRunner Enterprise opens.

LoadRunner Enterprise (2020-2020 SP1) Page 13 of 34
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Adding Vuser Scripts to LoadRunner Enterprise

The first step in your test design process is to add your Vuser script to LoadRunner Enterprise. Adding
the script involves two steps: Creating a scripts folder, and uploading the script to the folder.

How do | upload the Vuser Script?

You upload the script from within LoadRunner Enterprise, as follows:

1. Make sure the script is saved locally and is zipped.

2. Fromthe LoadRunner Enterprise navigation toolbar, click = and select Test Management (under
Testing).

3. Create a script folder.

a. Select Subject.

b. Click 5 New Folder, and specify a name for the folder, for example, Scripts.
¢. Click OK to add the folder.

4. On the module toolbar, click v Upload Script. The Upload Scripts dialog box opens.
5. Inthe Select Folder box, select the scripts folder you created above.

6. Click the Select button and navigate to the location of the zipped script file.

7. Click Upload to upload the script.

Monitoring Performance Tests

You monitor performance test execution using the LoadRunner Enterprise online monitors.

For example, you use the System Resource monitors to monitor a machine's system resource usage
during a performance test and identify server performance bottlenecks.

A primary factor in a transaction's response time is its system resource usage. Using the LoadRunner
Enterprise resource monitors, you can monitor the Windows Resource usage on a machine during a test
run, and determine why a bottleneck occurred on a particular machine.

What is a monitor profile?

To monitor server resources during the test, you select the type of monitors to run and the servers
whose resources you want to monitor. You then add the measurements to monitor for each server.
These monitor settings can be saved as a monitor profile which can be used by any performance test in
your project.

The following section will show you how to create a monitor profile and how to add a Windows
Resource Monitor to it.
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How do | create a monitor profile?

You create and configure monitor profile as follows:

1. Fromthe LoadRunner Enferprise navigation foolbar, click = and select Monitors (under Assets).

2. Create afolder for the monitor profile.

A
3. Select the folder, and click the New Monitor Profile I;l button. The Create New Monitor Profile
dialog box, enabling you to add a new monitor profile.

4, Enter the required information and click OK to add the monitor profile to the folder.
M E s X B X
Y

|
v @l Resources

v il Quick_Start_Monitor_Profiles
MP1

5. Inthe Monitor Profile page, click the Add Monitor * button. In the Add New Monitor page that
opens, select the monitor that you want to run.

6. Select Windows Resources. The Edit Monitor dialog box opens, enabling you to select the Windows
Resources counters you want to monitor.

7. Enter the desired information, and click Save. The monitor is added to your monitor profile.

You will add the monitor profile to the test as part of the test design process.

Creating Performance Tests

To create a test, you begin by creating a test folder, and then creating the test and adding it to the
folder. In the next section, you will learn how to design the test in the Test Designer.

How do | create a performance test

You create the test as follows:

1. Fromthe LoadRunner Enferprise navigation toolbar, click = and select Test Management (under
Testing).

2. Inthe test management tree, select the Subject root folder, click New Folder B. Type a folder
name and click OK.

3. Select the folder from the tree.

4. Click New Test + Fillin the fields in the Create New Performance Test dialog box.
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Designing Performance Tests

You design your performance test in the Performance Test Designer.

How do | open the Performance Test Designer?

You open the test designer as follows:

1. Fromthe LoadRunner Entferprise navigation toolbar, click = and select Test Management (under
Testing).

2. Select the test you created above, and click the Edit Test button on the toolbar. The Performance
Test Designer opens.

How do | design the performance test?

From the Groups & Workload view in the Performance Test Designer, you perform the basic test design
steps. You design the test as follows:

1. Assign a Controller to the test.

a. Click the O browse button adjacent to the Controller box. The Select Controller dialog box
opens.

b. Select Specific.

c. Select fromthe list the host machine that has been assigned the Conftroller and Load Generator
(C+LG) purpose.
2. Add Vuser scripts.
a. If the Scripts Tree pane is not displayed on the right, click the Select Scripts button on the

toolbar to open it. The Scripts Tree displays the script that you uploaded previously to
LoadRunner Enterprise.

Groups Scripts Tree # X
m Moise
& select Scripts El Assign1Lc  BY LG Management | & Virtual Location Editor.. -0
Vusers  Group Name Script Name Script Type Load Gener; ” 1l Subject
¥ @l Scripts
Er script_T

b. Inthe Scripts Tree, select the script and click the left arrow to add it to the test. The script
appears in the Groups pane.

Vusers  Group Name Script Name Script Type Load Generators Virtual Location Tag

Insights (D

Select virtual

10 script_1 script_ Web - HTTR/HTML
ocation

3. Add load generators.
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a. Inthein the Load Generators column of the Groups pane, click the Select load generators link.

Load Generators «

Select load generators

The Assign Load Generators to Groups dialog box opens.

b. Inthe Groups column, select the Vuser groups to use in the test.

¢. Inthe Load Generators column, expand the Specific tab, and from the list that appears, select
the host machine that has been assigned the Controller and load generator (C+LG) purpose.

d. Click Assign and then click OK.

4. Configure the schedule settings.

A schedule defines the actions of the Vusers for the performance test run, for example the behavior

of 10 Vusers emulating 10 users simultaneously logging on to the same Web site.

Because typical users do not perform the same action simultaneously, the Scheduler allows you to
schedule a performance test according to a more realistic portrayal of typical user behavior.

Define the schedule as follows:

In the lower area of the Groups & Workload tab, in the Global scheduler pane, click in each of the

schedule actions in the Actions grid and define them as follows:

o Initialize.

m

00:00:00 | (HHMMSS) affer initial

all Vusers simultaneous ) Wait fi

o Start Vusers.

Start All Vusers | gradually
art Vusers

Jusers every | 00:00:30 (HH:-MM:55)

o Duration.

Run | for ~ [ 00.00:10:00

op All Vusers | gradually

every | 00:00:30 (HHMM:SS)

Viusers

LoadRunner Enterprise (2020-2020 SP1)
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The schedule graph displays a graphical representation of the defined schedule. The lines in the

graph correspond to the actions defined in the Actions grid.

Yusers

0

00:00:00 00:02:00 00:04:00 00:06:00 00:08:00 00:10:00 00:12:00

Time

00:14:00

How do | add the monitor profile to the test?

You add the monitor profile to the test as follows:

1. Inthe Performance Test Designer, select the Monitors tab.

2. On the toolbar, click Add Monitor Profile. The Monitor Profiles pane opens on the right, displaying

the available monitor profiles.

3. Inthe Monitor Profiles Tree, select the monitor profile and click the left arrow to add it to the test.

LoadRunner Enterprise (2020-2020 SP1)
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Chapter 4: Running Performance Tests

This lesson explains the steps that are necessary before you run the performance test, and how to begin
test execution.

In this lesson you will learn about:

e "Creating Test Sets" below
e "Reserving Timeslots" on the next page

¢ "Running Performance Tests" on page 21

Creating Test Sets

The next step in the performance testing process is the creation of a performance test set.

What is a test set?

After you design the performance test in the Testing module, you organize the test execution by
creating a test set, and adding an instance of the test to the test set. The purpose of a test set is to
enable you to group together tests that were created for similar goals.

How do | create a test set?

You create the test set and add the test to it as follows:

1. Create the test set.

a. Inthe Performance Test Designer, click the Run button at the bottom of the page. The Assign
and Select Test Set dialog box opens.

Tip: You can also create or assign a test set from the Create New Performance Test
dialog box. For details, see "How do | create a performance test" on page 15

b. Click the Root test set folder, and click the i New Folder button. Specify a name for the Test
Set folder, for example, Test_set_folder.

c. Click OK to add the folder.

d. Select the folder you created above, and click the * New Test Set button. The Create New
Performance Test Set dialog box opens.

e. Enter the test set name. Click OK. The test name is added to the tree.
2. Assign the performance test to the test set.

a. Select the test set and click Assign.
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b.

Click OK. Your test is assigned to he test set.

Assign and Select Test Set
Create a new test set assignment or select in which test set to run.

+ Assign Test Set X Remove from Test Set
Test Instance ID Test Set Test Instance Path

ect Set : = -

Responsible

Reserving Timeslots

Before you run the test, you reserve a timeslot to ensure that the resources needed will be available for
the duration of the test.

How do | reserve a timeslot?

1. Fromthe LoadRunner Enterprise navigation toolbar, click = and select Timeslots (under
Resources).

2. Click the New Timeslot * button. The Add New Timeslot dialog box opens.

Define the following information:
Start. Choose Manually as the method for executing tests. The timeslot reservation reserves

testing resources only.

Name. Enter a name for the timeslot.

Test instance. Select the test you created and the test set instance to link to the timeslot. The
number of Vusers and hosts that were defined as part of the test design process are

automatically displayed.

Duration. Set the start time, and enter a duration for the test.

Post run action. If the administrator did not set an action across the project (the options are

available for selection), select Collate and Analyze.

4. Click Calculate Availability. The availability of the requested resources during the selected timeslot
is calculated. The results of this calculation are displayed in the Timeslot Status tab and graphically
on the time chart.

LoadRunner Enterprise (2020-2020 SP1)
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Add New Timeslot

<

* Add Automatch LG * Add Specific

Demands
Start: @ Manually () Automatically 13 -
Mame: Quick_Start_Timeslot
_ Host Type
&5t Instance: Tesr 125 (E]W| | Test_sef\Test f v
. Controller + LG
Jusers 50 from test + additional: Q :
VUDs: (out of 50 0%
Durafion: Hours 0% Minutes 30 %
Start Time Past run action:
Start Time 724(2018 = H :
End Time: 72402003 [ = H

Choose Timeslot:

]

06:00 07:00 08:00

st Time Avsilable Sterr Time  [K] Unavailsble Starr Time

Timeslot status Pool and project

Timeslot can be reserved

09:00 10:00 11:00 12:00

Properties

Collzte and Analyze

July 24 2018

Calculate Availability

Note: If the timeslot cannot be reserved, reselect your resources or adjust the start time,

taking info account the reasons displayed in the Timeslot Status tab.

5. When you find a valid timeslot, click Submit to save the timeslot.

Running Performance Tests

Now that you have designed the performance test, added an instance of the test to a test set, and
reserved a timeslot for the test, you are ready to run the test and observe how your application

performs under load.

How do I run the performance test?

You run the performance test as follows:

1. Fromthe LoadRunner Enterprise navigation toolbar, click = and select Test Management (under

Testing).
2. Select your test in the fest management free.

3. Click the Run Test button. The Run Performance Test dialog box opens.

LoadRunner Enterprise (2020-2020 SP1)
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4. Click the Reserved Timeslot tab.
5. Select the timeslot you reserved, and click Run.

The Initializing Run page displays the performance test initialization steps performed by
LoadRunner Enterprise, and the status for each step. If each step is completed successfully, the
performance test starts running and the Performance Test Run page opens. The Test Run page
enables you to manage and monitor the test as it runs.

What does the Performance Test Run page display?

The Performance Test Run page is the control center from which the test run is managed and
monitored.

TestRuns>Run1d22 | Test Snapshot > gv Test Id 21 Dashboard Results Event Log
= . . 37 e—
) Running 00:01:05 Running 0.00 0 o m 2 3 0 2 [} :
Graphs Groups Transactions Messages @

Search Y oo rAa

& Vusers Details & Run Vusers B Load Ge&gralors EG Timeslot Duration B Monitors v More v oo La 2) Basic Graphs
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The Performance Test Run page displays the following:

Pane/Tab Description

Summary The Summary pane at the top of the page displays a synopsis of the running
performance test.
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Pane/Tab Description

Test run Beneath the Summary pane is the Test Run Details area which provides four views:

views o Graphs. This is the view displayed in the above image. This view displays performance

measurements for those resources being monitored in the test. This enables you to
monitor how the application under test is performing in real time and identify where
potential bottlenecks exist.

¢ Groups. The Groups view displays the statuses of the Vusers in each Vuser group in
the performance test.

o Transactions. The Transactions view displays how many transactions have been
executed successfully or unsuccessfully.

e Messages. The Messages view displays error, warning, debug, and output messages
that are sent to the Controller by the Vusers and load generators during a test run.

Tabs .
On the right of the graphs pane, click = and select one of the following:

o Graphs: Displays a list of the configured online graphs. You can select which graphs
to display in the Graphs view.
¢ Topology: Displays any defined topologies for the test.

« Diagnostics: Displays diagnostics data collected from the test.
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This lesson explains how to analyze test run data using LoadRunner Analysis, and how to view
performance improvements and regressions using the Trend Report feature.

In this lesson you will learn about:

¢ "Analyzing Performance Test Run Results" below

¢ "Viewing Performance Improvements and Regressions" on page 29

Analyzing Performance Test Run Results

Now that you have completed running the performance test, you can use LoadRunner Analysis to
analyze the performance data generated during the test run. Analysis gathers the performance data
into detailed graphs and reports. Using these graphs and reports, you can pinpoint and identify the
bottlenecks in the application, and determine what changes need to be made to the system to improve
its performance.

How do | view Analysis information?

« To view Analysis data for your actual performance test, you perform the following steps:
a. Install Analysis

You can download Standalone Analysis from the From the LoadRunner Enterprise navigation

toolbar, click = and select Download Applications > Standalone Analysis.

b. Collate and analyze the results for the test run.

i. Fromthe LoadRunner Enterprise navigation toolbar, cIickE and select Test Runs. Select
the performance test you just ran in the test management tree, and click the Runs tab.

ii. If the test runisin the Before Collating Results state, right-click the run, and select Collate.
LoadRunner Enterprise collates the results for the test run

iii. When result collation has finished, and the test run is in the Before Creating Analysis Data
state, right-click the run, and select Analyze.

iv. When LoadRunner Enterprise has finished analyzing the results, download the Results_
<#>.zip file for the test run.

c. Open the Analysis session file for your performance test.
i. In Analysis, select File > Open. The Open Existing Analysis Session dialog box opens.

ii. Click File System, and navigate to the Results_<run_id>.zip file for the instance of your
performance test that you want to analyze.

iii. Double-click the Results_<run_id>.zip file. The Analysis session file is opened in Analysis.

For information about how to work within Analysis, see the LoadRunner Professional
Help Center.
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o To provide for more interesting results, a sample Analysis session is provided, which is based on a
performance test similar to the one you ran. For details on how to open the sample Analysis session,
see the LoadRunner Tutorial.

The data contained in the sample session is examined in more detail in the sections that follow.

Did | reach my goals?

Analysis opens displaying the Summary Report. The Summary Report provides general information
about the performance test run. In the Statistics Summary of the report, you can see how many Vusers
ran in the test and view other statistics such as the total/average throughput, and the total/average
hits. The Transaction Summary of the report lists a summary of the behavior of each transaction.

How can | view the graphs?

The graph tree in the left pane of the Analysis window shows the graphs that are open for viewing.
From the graph tree, you can choose to open new graphs and remove graphs that you no longer want
to view. The graphs are displayed in the graph viewing area in the right pane of the Analysis window.
You can view data from the selected graphs in the graph legend in the lower pane of the window.

As an example, we will now analyze the Average Transaction Response Time graph. Using this graph,
you can view the behavior of the problematic transactions during each second of the performance test
run. In this section, you view the behavior of the check_itinerary transaction.

To open and analyze the Average Transaction Response Time graph:

1. Choose Graph > Add New Graph. The Open a New Graph dialog box opens.

2. Under Transactions, select Average Transaction Response Time.
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3. Click Open Graph. The Average Transaction Response Time graph opens in the graph viewing

area.

Click Close to exit the Open a New Graph dialog box.
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In the legend, click check_itinerary. The check_itinerary transaction is highlighted in the graph and
in the legend below the graph.

Notice how the average response time of the check_itinerary fransaction fluctuates greatly
compared to the other transactions at the bottom of the graph, which follow a more or less stable
average response time.

How can | compare data from different graphs?

You can join two graphs together to see the effect of one graph's data upon another graph's data. This
is called correlating two graphs. For example, you can correlate the Running Vusers graph with the
Average Transaction Response Time graph to see the effect of a large number of Vusers on the
average response time of the transactions.

1
2.

Choose Graph > Add New Graph. The Open a New Graph dialog box opens.

Under Vusers, select Running Vusers.
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3. Click Open Graph. The Running Vusers graph opens in the graph viewing area.
Click Close to exit the Open a New Graph dialog box.
=
4. Select the Running Vusers graph and click the Merge Graphs button i on the main toolbar.
5. From the Select graph to merge with list, select Average Transaction Response Time.
6. Inthe Select type of merge area, select Correlate, and click OK.

The Running Vusers and Average Transaction Response Time graphs are now represented by one
graph which opens in the graph viewing area.
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Another Analysis tool, Auto Correlate (click = ), merges all graphs containing data that could have
had an effect on a given transaction. Correlations of the transaction with each element are displayed,
allowing you to deduce which elements had the greatest effect on the given transaction.

How can | sort graph data?

You can filter graph data to show fewer fransactions for a specific segment of the performance test, and
you can sort graph data to show the data in more relevant ways. For example, you can filter the Average
Transaction Response Time graph to display only the check_itinerary fransaction.
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1. Click Average Transaction Response Time in the graph tree to open the graph.

T
2. Select the graph and click the Set Filter/Group by button E .
3. In the Transaction Name value box, select check_itinerary and click OK.

The filtered graph displays only the check_itinerary transaction and hides all the other transactions.

How can | publish my findings?

You can publish the findings from your analysis session in an HTML or Microsoft Word report. The
HTML report can be opened and viewed in any browser. The Word report is more comprehensive than
the HTML report, enabling you to include general information about the performance test and to
format the report to include your company's name, logo, and the author's details.

For details about analyzing performance test results, refer to the LoadRunner Analysis User Guide.

Viewing Performance Improvements and
Regressions

A trend report is a LoadRunner Enterprise feature that allows you to view changes in performance from
one performance test to another, or across several performance tests. By analyzing these changes, you
can easily identify improvements or regressions in the measurement's performance.

For example, if you would like to analyze the performance trend of the average transaction response
time measurement of Transaction X, then the trend report would display the changes in the response
time from one test to the next, clearly indicating whether this measurement improved (where the
response time decreased) or regressed (where it increased).

What steps are involved in working with trend reports?

The process of creating and viewing a trend report involves the following steps:

¢ Step 1 - Creating the trend report. Creating the basic tfrend report by defining its name, description
and selecting a femplate.

o Step 2 - Adding test runs to the trend report. Exiracting test run data from Analysis to the trend
report.

o Step 3 - Viewing trend report data. Opening the trend view and analyzing the trending information.

Creating the Trend Report

You create the trend report from the main Trend Reports page.

To create the trend report:
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1. Open the main Performance Trending page.

From the LoadRunner Enterprise navigation toolbar, click = and select Performance Trending
(under Applications).

2. Open the Trend Report Creation page.

On the Performance Trending page, click the * New Trend Report button. The Create New Trend
Report page opens.

Create new trend report

General Details

General Contents and Layout

Template Description

Transactions Trends

Transactions and Monitors Trends

Trend by Quality Attributes

User Defined

3. Define the General Details and Content and Layout settings.
a. Inthe Create New Trend Report page, define the following information:
o In the General Details pane, enter a name and description for the trend report.
o In the General Contents and Layout pane, select the Transaction Trends template.

b. Click Create to create the trend report. The Select Test Runs to Trend Report dialog box
superimposes on the Trend Overview tab.

4. Add Performance Test Runs to the Trend Report.

From the Project, Test Set and Test lists respectively, select the performance test that you want to
trend. All analyzed instances of the performance test appear in the table.
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Select Test Runs to Trend Report

Project  |A_PROJECT ™ Test Set test_set | Test | Test 123 |

O

Run ID Run Name Time Range Exec Date Duration Max Vusers ;:::L';ransachons Total Errars

~ Test Name test1; (3 Runs)

7 AdhocRun_2017-01-11 145417 Complete & 11/01/2007 145554 2 (min) 10 134 o]
g .Et:.?cwl]?\m_,;- e Complete & 2 (min 10 134 1
IS
AdhocRun_2017-01-0 Complete 3 0
4 094557 Complete & 2(min 10 136 o]
ﬂLlse CTRL + left mouse click to select multiple runs
Note: only analyzed test runs will appear in the table above. Adding runs to the report may take several minutes

Cancel

Select those analyzed instances of the test that you want to add to the trend report, and click Add.
LoadRunner Enterprise uploads the test runs from Analysis and adds them to the trend report. The
trend report opens displaying the Trend Overview tab.

Notes:

o To add test runs to the trend report, there must be a data processor in your project's host
pool. For details, contact the Administrator.

e The process whereby LoadRunner Enterprise extracts the performance test data from
Analysis is very labor intensive on the data processor and may take anywhere from
several minutes to over an hour. For best results, use a data processor dedicated for this
purpose.

Viewing Trend Report Data

In the following section, we will look at trending information for the average transaction response time
measurement only.

To view trending information:
On the trend report, click the Performance tab.

In the trend view that opens, you will see a table that displays the transactions that were present in the
test run, as well as the average fransaction response times for each selected instance of the test run.

By comparing these average transaction response fime figures, you can identify if the performance of
the transaction improved or regressed from one test run to the next.
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The following example illustrates this point.

Transaction Response Time(Compare to baseline)

Average
MName Type

6/24/2012 (3[Ba=ze]) &/24/2012 (4] 6/24/2012 (5] 6/24/2012 (&)
All TRT 4,567 1,22 (-73.29%) 2037 (-49,.2%) 12,455 (+172.72%)
TRH_01 TRT Z.045 4,073 (+99.17%)  2.035 (-0.49%) 1.05 (-48.66%)
TRE_0Z TRT 1,045 2,07 (+98.09%) 1,015 (-2.87%) 1,051 (+0.57%)
TR¥_03 TRT 3,053 3067 (+0.46%) 2,009 (-34,2%) 2,654 (-13.07%)
TR¥_04 TRT 6,055 6,868 (+13.43%)  5.011 (-17.24%)  7.05 (+16.43%)

In the trend view shown above, four fransactions (TRX_01, TRX_02, TRX_03, and TRX_04) are
displayed and their average Transaction Response Time measurement is being trended from four
performance test runs: 3, 4, 5, and 6.

Test run 3 has been automatically defined as the baseline run, (as indicated by the word Base in
brackets). This means that the average transaction response times contained in the other tests are
compared to test run 3 only.

In test run 3, the average transaction response time for TRX_01 was 2.045. The average fransaction
response time for the same fransaction in test run & was 4.073, which represents a slower response time
and therefore a regression in the performance of this measurement. The percentage difference
between the two figures is displayed in parenthesis, in this case +99.17%.

In test run 6, the average transaction response time for TRX_01 was 1.05, which represents a faster
response time that test run 3, and therefore a performance improvement. The percentage difference
between the two figures is displayed in parenthesis, in this case -48.66%.
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Send Us Feedback

Let us know how we can improve your experience with the Quick Start.
Send your email to: docteam@microfocus.com
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